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PhotoShop™ User's Manual

PhotoShop is powerful image processing and photo retouching program.  It works with
bitmaps, gray level images, indexed color images, and full 24-bit color pictures.

Some of the key features are:

•Very fast dithering allows the internal data structure to be independent of the display device.
This means that you can work with 24-bit images on an 8-bit display, or a mac plus, or
anything in between.  The program supports 32-bit quickdraw, so that when these
devices are available, you can view images directly without dithering.

•Speed.  All of the retouch, math, resizing, conversion and other  calculation tools have been
highly optimized.  They operate generally much faster than similar programs.

•Virtual Memory.  Even if the user has very little RAM (1 meg), he can  still work with pictures
up to 64 megabytes, if there is available disk space. The program will operate faster if
there is RAM for the whole picture, but the virtual memory scheme is very fast, and the
program remains responsive.  This is especially important because of the current high
price, and delivery delays of RAM.

•Math tools.  A large selection of math tools allow the user to add, subtract, multiply,
difference, minimum, and maximum any two images.These tools can be strung together
to perform very sophisticated operations, such as bluescreen composites or complex
feature extraction.

•8-bit selection mask.  PhotoShop is the only program that offers a multi-bitplane selection
mask with a variable feather edge radius.  This allows you to feather in brightness and
color changes, and do perfectly anti-aliased photo composites.  The user can copy
information from any channel of the image into the selection mask, or vice versa.  For
example, if he uses the math tools to extract an anti-aliased matte of some feature in the
picture, he can then copy that matte into the selection mask, and use that to cut and paste
that feature elsewhere, or adjust color balance of only that selection.

•File format support
a) large variety makes the program a universal translator.
PhotoShop reads AND WRITES:

PICT files
PICT resources
Amiga IFF/ILBM
Compuserve GIF
MacPaint
Thunderscan
TIFF
RIFF  -  well OK, not yet, but soon.
PIXAR
Pixelpaint
PhotoShop
A very smart and flexible raw format.
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b) Format conversion lets you convert any format into any other.
for example:

8,4,2-bit color ->   24-bit color
24 bit color     ->   8,4,2-bit color (adaptive palette selection)
8,4,2-bit gray  ->   halftone bitmap
color            ->   b&w
b&w              ->   color

etc.

•Filters are resource driven, leaving the program open-ended for third party expansion.   (A
filter is any piece of code that changes the image)   These bits of code can be compiled,
and pasted into the program with ResEdit.  This feature is not yet Implemented

•The program allows you to work in RGB, CMYK, HSV, or HSB space.

•Brightness level, contrast, hue, saturation, gamma, and color balance adjustments.

•Retouch tools include:
Marquee tool
Lasso tool
Zoom in/out tool
Hand tool
Pencil
Paint brush
Airbrush
Bucket fill
Eraser
Smudge
Blur
Sharpen
Eyedropper



©1988 John and Thomas Knoll        Preliminary  Documentation

PhotoShop™    user's manual                                26/05/1988 page3

The Tool Palette

To use a tool, select it by clicking on it.  The tool icon becomes highlighted to indicate that it is
the current tool.  The cursor will take the shape of current tool.

 Lasso Tool

Selects an arbitrary region of an image.

Add to a selection by holding down the shift key and making another selection.  The area you
just selected will be added to the current selection.

Subtract from a selection by holding down the command key and making another selection.
The area you just selected will be removed from the current selection.

Take the intersection of the current selection and a new selection by holding down the
command and shift keys while making the new selection.

Double-click on the lasso tool to set the radius of the feather edge.

Once an area has been selected, color balance, level, Hue/Saturation, mapping,
flipping, rotating and filters only affect the selected area, but the effect will be faded in
over the width of the feather edge.  Using a large value for the feather edge, and then
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using the Adjust Levels... command to brighten the image will gradually bring in the
effect in the area of the selection.  If the feather width is large, and the selected area is
small, the Lasso tool will not select anything (because the maximum mask value is
always below 50%, and there would be no screen feedback).)

A selection can be dragged with the mouse.  An outline of the selection moves with the mouse.
When you release the mouse, the image appears in the new position, but remains 'floating'
until it is deselected by clicking the mouse outside the selection.

Hold down the option key to leave the original selection in place and drag a copy.

The feather edge does not work with bitmaps or indexed color images.  If you need to do a
faded adjustment on an indexed color image, convert it to RGB, do the adjustment, and then
convert it back to indexed color.

 Marquee Tool

Selects a rectangular region of an image.

Double-click on the marquee tool to change its parameters.

While the marquee tool has no built-in feather edge, a selection can be feathered with the
Feather... command  under the Edit menu.

Holding down the shift key constrains the selection to the aspect ratio selected in the marquee
options dialog box.

Holding down the command key selects a single horizontal scan line.  Holding down the
command and shift keys selects a single vertical scan line.  Use the arrow keys to shift the scan
line one pixel.  Holding down the shift key makes the arrow keys shift a line one-quarter pixel.

Like the lasso tool, only selected regions are affected by image adjustment commands.
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 Grabber Tool

Scrolls the window.

Double-click on the grabber tool to reset the window size and magnification to the largest size
that will fit entirely on the screen.

When an image is larger than the window, the grabber tool can be used to scroll around
in the window.  This is the only way to scroll in full screen mode.

Many of the painting tools turn into the grabber while you hold down the option key.

 Zoom Tool

Zooms in or out of an image.

Double-click on the zoom tool to reset the magnification to 100%.

The zoom tool zooms out if the command key is pressed.

 Digitize Tool

Is not yet implemented.

 Eraser tool

Erases pixels in the image and sets them to the background color.

Double-click on the eraser tool to erase the entire image.

The eraser tool remains the size of the cursor regardless of magnification level.

 Bucket Fill

Is not yet implemented.

Click on the  bucket tool to hear a beep sound.
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 Eyedropper Tool

Selects the foreground or background color from the image.

Click anywhere in the image to select that color.  You can drag across the image and watch the
foreground color change.

Clicking in another window with the eyedropper does not bring that window to the front.  This
makes it convenient to have a palette document to select colors from.

Hold down the shift key and click to select the background color.

Double-click on the eyedropper to reset the foreground color to black and the background color
to white.

 Paint brush

Paints with the Foreground color.

Double-click on the paintbrush to set its parameters.

Click on the brush shape that you want.

The spacing parameter can be a number between 1 and 999.  If you set the spacing to 20 pixels,
the paintbrush will lay down a dot every 20 pixels while you drag.

The fade-out parameter controls the distance in pixels over which the paintbrush fades out.  A
value of zero turns off the fade-out option.
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Mode:

•Normal mode is the default.  In this mode, the foreground color
replaces the area under the cursor.

•In Color Only mode, the paintbrush tints the picture to the hue of the
foreground color without changing the brightness.  This can be
used to colorize a black & white picture, or tint a color image.

•Darken Only mode only changes pixels that are lighter than the
foreground color, but leaves darker pixels unchanged.

•Lighten Only mode only changes pixels that are darker than the
foreground color, but leaves lighter pixels unchanged.

The command key turns the paintbrush into the eyedropper while pressed.

The option key turns the paintbrush into the grabber while pressed.

In monochrome and RGB mode, the paintbrush is anti-aliased.

The paintbrush works only on gray level or RGB images.

 Pencil

The pencil works just like the paintbrush, except that the pencil is not anti-aliased, and does not
have fade-out or repeat rate parameters.

This is the only painting tool that can be used on indexed color images.

 Airbrush

The airbrush works just like the paintbrush, except that it slowly deposits paint as the mouse
button is held down.

The airbrush also has a Pressure parameter that works like air pressure on a real airbrush.  It
takes a number between 1 and 10.  1 is low pressure and deposits paint slowly, and 10 is high
pressure, and deposits paint more rapidly.

The airbrush works only on gray level or RGB images.
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 Smudge Tool

The smudge tool smears a picture much like rubbing your finger on an oil painting, the paint
drags along for a little while.  The pressure parameter controls how long the trail lasts.  10 is
considered infinite pressure, and the trail does not fade out.

The smudge tool works only on gray level or RGB images.

 Blur Tool

The blur tool blurs the image under the cursor.

The blur tool works only on gray level or RGB images.

 Sharpen Tool

The sharpen tool sharpens the image under the cursor.

The sharpen tool works only on gray level or RGB images.

Foreground & Background Color

Click on the foreground or background color to select the new color from the Apple color
picker.
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The File Menu

The file menu is for opening, closing, creating new, printing, and scanning files.  The dialog
boxes are the same as most other Macintosh applications, except that a few of them have pop-
up menus to select the file format.

File Formats

PhotoShop supports a wide variety of file formats, including TIFF, RIFF, PICT files, PICT
resources, Compuserve GIF, Thunderscan, IFF, QDV, MacPaint, PIXAR, PixelPaint, our
own PhotoShop format, and a very flexible raw input format.

TIFF
TIFF is a high-resolution color and gray-level scanner format.  It supports very large
size images at up to 24 bits per pixel.  Many commercial scanners output TIFF images,
and many page-layout programs import this format.

RIFF - not implemented
RIFF is a high-resolution color and gray-level scanner format used primarily by
ImageStudio™.

PICT files
PICT is a file format supported by Apple Computer Inc.  It supports 1,2,4, and 8 bits
per pixel, black and white or indexed color.

PICT resources
PICT resources are used as startup screens and by program developers.  Grayview uses
PICT resources.
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GIF
GIF is an indexed color file format developed by Compuserve.  GIF viewers are
available for a wide variety of machines.  It is a highly compressed format supporting
up to 8 bits per pixel.

Thunderscan
Thunderscan is a low cost gray level image digitizer.  It supports 5 bit per pixel, that is,
32 levels of gray.

IFF
IFF is a file format used by Amiga computers.

MacPaint
MacPaint pictures are 8 1/2" x 11" encoded bitmaps.

QDV
QDV is a generic indexed color format. The first four bytes are two short integers
describing number of rows and columns. The next two bytes are a short integer
describing the number of entries in the color table, followed by the RGB values of the
color table itself, and then followed by the data.

Pixelpaint
Pixelpaint files are 8 bit color paint files.

PIXAR
PIXAR files are used by PIXAR image computers.

PhotoShop
PhotoShop format is the only type here that supports unlimited size images of any
number of bitplanes.  It supports bitmaps, 2,4,8-bit gray, 2,4,8-bit indexed color, 24-
bit color, and multichannel images that consist of up to 16 8-bit channels.  Many
satellite photos and medical images use four or more channels.  PhotoShop files load
and save extremely fast.

Raw
Raw format is raw bytes on disk, interleaved or non-interleaved, any number of
channels.  The raw format can be used to import or export files that do not use any of
the above file types.  For example, BarneyScan images can be read in in this way even
though there is no direct built in support of their format.
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New...

Creates an empty PhotoShop image.  This image can be black & white or color, and of any size
you specify.

Open...

Opens an image file from disk.  PhotoShop will show you all files created by PhotoShop or
other Macintosh applications that it knows how to read.

If an image is already open, you can open another view of that image with the Open...
command.  These windows can have different magnifications or viewing modes, and changes
made to the picture in one window will appear in the others.

A document remains open until all windows of that image are closed.
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Open as...

Sometimes PhotoShop will have to be told what format a file is in.  A picture downloaded from
an electronic bulletin board or online service may appear on the desktop as a generic
'document', so PhotoShop will not know what format it is.

If you transferred an IFF picture from an Amiga computer to your Macintosh, you would need
to open it with the Open As... command, and tell PhotoShop that the file is an Amiga
IFF/ILBM file.

The raw input format is very useful for importing images whose format is not directly
supported.  Many medical and satellite images are stored as raw bytes on disk, with any
number of channels in interleaved or non-interleaved order, and with some sort of header
describing the file.  The raw input dialog box can sometimes guess the parameters of a file, but
many times you will have to tell it the size of the image.

Sometimes it is possible to open damaged files using the 'raw' input format, if the file you are
trying to open is not encoded.  If you mistakenly leave a 'strip linefeeds' option on in a
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communication program when downloading a picture, the file may become unreadable, but can
still be opened as raw.

Use the pop-up menu at the bottom of the Open As... dialog box to select the file format.

Close

Closes the topmost window.  If this is the only window open on that file , the file is also
closed.  if you have altered the file, but not saved it, PhotoShop will ask you if you want to
save your changes.

Save

Saves the topmost file to disk in the format it was previously saved in.  If the file has not
already been saved, Photoshop will open the Save As... dialog box.
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Save As...

Saves the topmost file to disk.  PhotoShop will prompt you for a name and which format to
save in.  The default is PhotoShop format, but you can use any format that is compatible with
the data type of the image you are saving.  You cannot, for example, save a 24-bit picture in a
format that only supports 8-bit pictures, without converting it to 8 bits first with the Mode
menu.  Formats that are not appropriate for the current image appear dimmed.

It is possible to save a file on disk in a different format than previously saved with the same
name.  PhotoShop will ask you if you want to overwrite the existing file.
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Revert

Reverts a picture to the last saved version, Discarding changes since the last save.

Scanner Setup...

Sets up a scanner if one is installed.

Scan..

Scans an image into memory if there is a scanner installed in your system.

Page Setup...

Allows you to specify printing options for the currently selected printer.
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Print...

Prints the topmost image.

Preferences...

Allows you to specify your own personal preferences for how some parts of the program
operate.

The leave space for icons option tells PhotoShop not to cover up the disk and trash can icons
on the desktop if you are running under multifinder, when opening a new window or
expanding one already there.

The Colored separations option displays the red, green, and blue channels in their natural
colors when viewed individually. (this also works with CMYK seps.)  If this option is turned
off, the individual channels are displayed as gray levels.

The Use system palette option always displays images using the system palette.  This allows
you to view pictures in different modes at the same time.  For example, if you have a
monochrome image in one window, and an RGB image in another, this option allows you to
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see them both at the same time.  Since there are only 16 gray levels in the system palette, this
option is best turned off with monochrome pictures.

The Trim white space option crops out empty pixels around an image when it is opened.  Some
paint programs force you to save a fixed size picture even if what you have painted is much
smaller.  This option saves memory by getting rid of unused border area.

The Adjust aspect ratios option applies only to Amiga IFF/ILBM and ThunderScan files.
These formats save non-square pixels.  With this option on, PhotoShop interpolates to prevent
the image from appearing distorted.

The clipboard resolution option applies only to exporting cut images to other applications.
When you switch out of PhotoShop under Multifinder, or quit the program, the contents of the
clipboard are converted to pict format in the specified resolution.

The Interpolation method option lets you set what type of interpolation is used for arbitrary
resize, arbitrary rotation, and all of the Effects menu items.

Nearest neighbor is very fast, but the quality is marginal.

Bi-linear interpolation looks very good, and is good enough for most purposes.

Bi-cubic interpolation is extremely accurate and always produces the best possible results.  this
method requires roughly twice the time of bi-linear interpolation.

When you quit the program, if you have changed the preferences, PhotoShop will ask you if
you want to save these as the default.
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Quit

Quits PhotoShop and returns to the Finder.

If you have any open documents that have unsaved changes, Photoshop will ask you if you
want to save them.

The Edit Menu

The edit menu contains commands for editing documents.

Undo

This command can be used to undo the last command that altered the image.  Almost any
command can be undone, except Close, Revert, and Save.
After you have undone a change, the Undo menu item becomes Redo.  Selecting this command
lets you undo the undo command.
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Cut

This command cuts the selected region from the image onto the clipboard.

Copy

This command copies the current selected region from the image onto the clipboard.

Paste

This command pastes the contents of the clipboard into the topmost image.

You cannot paste into a lower resolution image mode.  For example, you cannot paste an
indexed color image into a bitmap, or a 24-bit picture into an indexed color image.  You can,
however, paste an indexed color image into a 24-bit picture, or a bitmap into a monochrome
image.

Clear

Clears the current selection to the background color.

The backspace and clear keys on the keyboard perform the same function.

Fill

Fills the current selection with the foreground color

Shift-backspace performs the same function from the keyboard.

Crop

Crops the image to the currently selected rectangle.  Everything outside the selected area is
deleted.

Paste Controls... are not implemented

This controls how the Paste function operates.  It allows you to control blend modes.

Select All

Selects the entire image.

Select Inverse

The Select Inverse command selects the area this is not selected.  Repeating the
command restores the original selection.
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Select Similar

This command performs a statistical analysis on the current selection, and then expands the
selection to contain all pixels that fall within the standard deviation of that area.

Select similar can be repeated to add to the selected area.  If it missed a part of the image that
you wanted, you can hold down the shift key, select a representative sample of the area you
want, and choose Select Similar again.

Select Fringe

Selects only the edge of the current selection.

Feather...

Feathers the edge of the current selection by the specified amount in pixels.

This is useful for feathering selections made with the marquee tool.

This works only on gray level or RGB images.
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The Mode Menu

Picture Mode

Inside PhotoShop, a picture can be a bitmap, a gray-level image, an indexed color image, a 24
bit RGB image, or a series of 8 bit channels.

Very important to understanding PhotoShop is the concept of a picture existing as a collection
of channels.  A gray level image exists in memory as a single channel.  A full color image
normally exists as three channels, a red channel, a green channel, and a blue channel.

Other types of images sometimes use more than three channels.  Satellite photos and medical
scanner images sometimes have four or more channels.  PhotoShop supports up to 16 channels
per image.

It is often very useful, for example, to allocate temporary scratchpad channels for storing the
result of a calculation command.
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Halftone

Converts a monochrome image into a bitmap.

You can select a dot size and size ratio in the dialog box.

Monochrome

Converts from halftone, indexed color or RGB to monochrome.  (8-bits/pixel)

Indexed Color

Converts from an monochrome or RGB image to indexed color.

When converting from monochrome to indexed-color, PhotoShop uses a grayscale palette, so
the image does not appear to change.
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When converting from RGB to indexed color, a dialog box appears prompting you for
resolution and palette type.  The best results are obtained by using adaptive palette selection and
diffusion dithering.

Indexed color images employ a color lookup table that can consist of any 256 colors.  It is
possible, for example, that a palette has only shades of blue and green, but no red.  If you then
wanted to airbrush some red into the image, there would no entries in the color table to
represent this.  For this reason, commands that would add new colors will not work with
indexed color images.  If you wish to do extensive editing of indexed color images, convert to
RGB color, edit them, and then convert them back to indexed color when you are done.

RGB Color

Converts from monochrome, indexed color, multichannel, or separations to 24-bit color.

Separations -CMYK

Converts the image from RGB to cyan, magenta, yellow and black separations.

 Separations -HSL

Converts the image from RGB to hue, saturation and lightness separations.  The individual
channels can be edited just like any monochrome images.

Separations -HSB

Converts the image from RGB to hue, saturation, and brightness separations.

Multichannel

Multichannel images are two or more grouped monochrome channels.
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Color Table

Applies only to indexed color images.

This menu is for altering the color table of an indexed color image.

Load Table...

Loads a color table from disk.  This feature is not yet implemented.

Save Table...

Saves a color table to disk.  This feature is not yet implemented.

Black Body

Changes the image's color table to a black body radiator.

Monochrome

Changes the image's color table to monochrome.

Spectrum

Changes the image's color table to a spectrum.

Channel...

Allows you to switch the display to individual channels of an RGB, CMYK, HSL, HSB, or
multichannel image.  Command-1, 2, 3, 4, etc. accomplish the same thing.  Command-0
switches back to displaying an RGB image in RGB mode.
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Delete Channel

Deletes the currently displayed channel of an image.  All higher numbered channels close in to
fill the gap.

Split channels...

Splits an RGB, CMYK, HSL, HSB, or multichannel image into separate monochrome
documents.

Merge Channels...

Merges a series of monochrome documents of the same size into an RGB, CMYK, HSL,
HSB, or multichannel image.

PhotoShop will then ask you which documents to assign to which channels.
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The Image Menu

The image menu controls transformations to the image.

Map

The map menu is for remapping images.

Invert

Inverts the image, making it negative.  This command can be used to make a negative image
positive.

Equalize

Equalize the histogram of an image.

Note that this command operates in HSV space, rather than RGB space.  Equalizing a color
image is not the same as equalizing each of its channels separately.
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When using the Equalize command, and only part of the image is selected, the programs
asks whether the whole image should be equalized based on the selected area, or just
equalize the selected area.

Threshold...

Displays a histogram of the current selection, dark on the left and light on the right.

Threshold sets all pixels brighter than a threshold level to white, and all pixels darker than
this level to black.  Dragging the slider changes this threshold.

On a mac II, PhotoShop animates the palette to simulate the threshold operation.  The image
memory is not changed until you press OK.
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Posterize...

Quantizes an image into a specified number of gray levels.  This command uses 'type
ahead', that is, it reads what you are typing and simulates that value.

Arbitrary...

Allows you to draw your own arbitrary correction map with a pencil tool.  Holding down
the shift key and clicking connects the dots with straight lines.

Adjust

The adjust menu allows you to adjust brightness, contrast, gamma, color balance, hue, and
saturation.
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Levels...

Histogram based brightness, contrast and gamma control.  If the Mac in running in 8 bit mode,
color table animation is used to simulate the effect on the controls on the image.  (This
simulation is exact for monochrome and indexed color modes, and approximate for color
mode).

Drag the sliders to adjust brightness and contrast. The gray slider in the middle controls the
gamma.

The Adjust Levels command uses a gamma curve when moving the middle gray level.
Gamma curves have the advantage in that they are additive, i.e. two gamma curves
applied sequentially has the same effect of a single, combined gamma curve.

Balance...

Adjusts the color balance.
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Hue/Saturation...

Adjusts the hue and saturation of an image.

The colorize option changes the selection to the selected hue, rather than rotate the color wheel.

Filter

Applies a filter to the current selection.

If nothing is selected, the filter is applied to the entire image.   If only one channel of an RGB
image is displayed,  this correction affects only the displayed channel, otherwise all three layers
are affected.

Indexed color images and bitmaps cannot be filtered.
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Add Noise...

Is not yet implemented.

Blur

Performs a very slight blur on the selection.

Blur More

Performs a more noticeable blur on the selection.

Convolve...

Allows the user to type in their own 3x3 convolution kernel.

Despeckle

Performs an edge preserving blur on the image.  This is useful for smoothing an RGB image
that has been converted from indexed color.

This filter is not yet implemented.

Diffuse

Randomly shuffles pixels within a small radius.  This is useful for hiding aliasing artifacts
known as 'jaggies'.

This filter is not yet implemented.
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Find Edges

Performs a Sobel edge operator on the image.  The resulting image is all black with white lines
at the edges of objects.

Gaussian Blur...

This is a variable radius blur.  Use this filter if you need a bigger blur than available with Blur
or Blur More.   Type in the radius of the blur.

High Pass...

This filter is not yet implemented.

Maximum

This is a dilation filter.

Median...

This filter is not yet implemented.

Minimum

This is an erode filter.

Motion Blur...

Simulates the blur from a moving object.

This filter is not yet implemented.
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Offset...

Offsets the selection the specified number of pixels horizontally and/or  vertically.

Sharpen

Performs a slight sharpening of the selection.

Sharpen More

Performs a stronger sharpening of the selection.

Star Lens

Simulates the effect of a star filter on the selection.

Trace Contour...

This filter is not yet implemented.

Repeat Filter

Repeats the last filter operation.  This menu item takes on the name of the last filter operation.
If the last filter operation was a Blur More, this command would be named Repeat Blur More.
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Calculate

The calculate  menu performs inter-channel arithmetic.  This is a very powerful menu and can
be used to accomplish some very sophisticated operations.

Add...

Adds two channels together.

If channel 1 has a gray level of 120 and channel 2 has a gray level of 60, they add up to a gray
level of 180.  Anything that adds up to a number greater than 256 is clamped to 256.
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Blend...

Blends two channels together with the specified ratio.

Composite...

Performs a photo composite.

Constant...

Sets a channel to a the specified constant gray level.
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Darker...

Compares the pixels from the two sources and always puts the darker of the two in the
destination channel.

Difference...

Takes the absolute value of the difference between two channels.

Duplicate...

This command copies one channel into another.

This command can also be used to copy from the selection mask into a channel, or from a
channel into the selection mask.
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Hypotenuse...

Takes the hypotenuse of two channels, that is, destination = sqrt(source 1 * source 1 + source
2 * source 2)

Lighter...

Compares the pixels from the two sources and always puts the lighter of the two in the
destination channel.

Multiply...

Multiplies the densities of two channels.  This simulates the effect of sandwiching two
transparencies together.

Subtract...

Subtracts two channels from each other with optional scale factor and offset.
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Measure

These commands display information about the selection.

Statistics

Is not yet implemented.

Histogram

Displays a histogram of the selection.

This is not yet implemented.

Calibrate...

Allows you to white, gray, or black balance an image based on the selection.

This is not yet implemented.

Save Points...

Writes out to a disk file coordinates and RGB values of a series of mouse clicks within the
image.

This is not yet implemented.

Flip

Flips the selection Horizontal or Vertical.

Rotate

Rotates the selection 180°, 90° left or right, or arbitrarily, the specified number of degrees.

Effects

These commands perform special effects upon the selection
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Resize

Resizes the selection.

This is not yet implemented.

Free Rotate

Allows arbitrary rotation of the selection.

This is not yet implemented.

Skew

This is not yet implemented.

Perspective

This is not yet implemented.

Distort

This is not yet implemented.

Resize Image...

Resizes the image.

In RGB or monochrome mode, this function uses the interpolation type set by the
Preferences... command.  This can be nearest neighbor, bi-linear, or bi-cubic.  The default is
bi-cubic.  This produces the best possible results.  In halftone or indexed color mode, this
command replicates pixels for an enlargement, or subsamples for reductions.  Better results on
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indexed color images can be obtained by first converting it to RGB, resizing it, then converting
back to indexed color.

The window button fills the rows and columns boxes with the size of the window.

The screen button fills the rows and columns boxes with the size of the screen.

The constrain button constrains the numbers in the rows and columns boxes to be the same
aspect ratio as the original picture.

If one of the rows and columns boxes is left blank, PhotoShop automatically fills in the other
number that preserves the aspect ratio.

The center image button changes the document size to the specified size, but leaves the image
the same size, centered in the document.

Zoom In

Doubles the displayed magnification of the image.

The current magnification level is always displayed in the title bar of the image.

Zoom Out

Halves the displayed magnification of the image.
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Set Scale...

Allows you to set the magnification or reduction to any integer, 1-16.

The Window Menu

The Window menu allows for fast switching between windows, or bringing to the front a
window that was hidden beneath the others.

Full Screen

Displays the image full screen, Hiding the menu bar and the tool palette.  Since the menu bar is
hidden, the only way out of this mode is to press command-f on the keyboard.
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